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Warranty

The material contained in this docu-
ment is provided “as is,” and is sub-
ject to being changed, without notice, 
in future editions. Further, to the max-
imum extent permitted by applicable 
law, Agilent disclaims all warranties, 
either express or implied, with regard 
to this manual and any information 
contained herein, including but not 
limited to the implied warranties of 
merchantability and fitness for a par-
ticular purpose. Agilent shall not be 
liable for errors or for incidental or 
consequential damages in connection 
with the furnishing, use, or perfor-
mance of this document or of any 
information contained herein. Should 
Agilent and the user have a separate 
written agreement with warranty 
terms covering the material in this 
document that conflict with these 
terms, the warranty terms in the sep-
arate agreement shall control.

Technology Licenses 

The hardware and/or software described in 
this document are furnished under a 
license and may be used or copied only in 
accordance with the terms of such license.

Restricted Rights Legend

If software is for use in the performance of 
a U.S. Government prime contract or sub-
contract, Software is delivered and 
licensed as “Commercial computer soft-
ware” as defined in DFAR 252.227-7014 
(June 1995), or as a “commercial item” as 
defined in FAR 2.101(a) or as “Restricted 
computer software” as defined in FAR 
52.227-19 (June 1987) or any equivalent 
agency regulation or contract clause. Use, 
duplication or disclosure of Software is 
subject to Agilent Technologies’ standard 
commercial license terms, and non-DOD 
Departments and Agencies of the U.S. Gov-
ernment will receive no greater than 
Restricted Rights as defined in FAR 52.227-
19(c)(1-2) (June 1987). U.S. Government 
users will receive no greater than Limited 
Rights as defined in FAR 52.227-14 

(June1987) or DFAR 252.227-7015 (b)(2) 
(November 1995), as applicable in any 
technical data.

Safety Notices

 A WARNING notice denotes a 
hazard. It calls attention to an 
operating procedure, practice, or the 
like that, if not correctly performed or 
adhered to, could result in personal 
injury or death. Do not proceed 
beyond a WARNING notice until the 
indicated conditions are fully 
understood and met.

A CAUTION notice denotes a hazard. It 
calls attention to an operating procedure, 
practice, or the like that, if not correctly 
performed or adhered to, could result in 
damage to the product or loss of important 
data. Do not proceed beyond a CAUTION 
notice until the indicated conditions are 
fully understood and met.

mailto:service.automation@agilent.com
mailto:orders.automation@agilent.com
mailto:documentation.automation@agilent.com
http://www.agilent.com/lifesciences/automation
http://www.chem.agilent.com/en-US/Contact-US/Pages/ContactUs.aspx
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Preface 

This preface contains the following topics:

• “About this guide” on page vi

• “Accessing Agilent Automation Solutions user information” on 
page viii
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About this guide

Who should read this guide

This user guide is for people with the following job roles:

 

What this guide covers

This guide contains the safety guidelines and the installation, setup, operation, 
and maintenance procedures for the Microplate Centrifuge.

This guide does not provide instructions for the VWorks software or third-
party software. See the relevant user guides for these products. 

What is new in this revision
 and 

Job role Responsibilities

Installer Unpacks, installs, and tests the Centrifuge before it is used.

Integrator Configures hardware and writes software.

Lab manager, 
administrator, 
or technician

• Manages the automation system that contains the 
Centrifuge

• Develops the applications that are run on the system

• Develops training materials and standard operating 
procedures for operators

Operator Performs the daily production work on the Centrifuge and 
solves routine problems.

Feature and description See…

Updated the compliance topic to include 
the South Korean Class A EMC 
declaration. Moved the general safety 
precautions, intended product use 
statement, and the list of safety labels.

“Safety and regulatory 
compliance” on page 3

Automation Solutions Products 
General Safety Guide

Updated the hardware overview to 
include the connection panel description.

“Connection panel” on page 10

Simplified and updated the software 
overview to reflect the latest versions.

“Software overview” on page 11

Updated laboratory requirements to 
include the labware specifications.

“Laboratory requirements” on 
page 15

Moved the unpacking procedures to a 
separate guide that is attached to the 
shipping container.

Microplate Centrifuge 
Unpacking Guide
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Software version

This guide documents Centrifuge Diagnostics version 8.0.

Related guides

Use this guide in conjunction with the following:

• Automation Solutions Products General Safety Guide. Provides general 
safety information and describes potential safety hazards that you might 
encounter when using Automation Solutions products. A copy of this safety 
guide is included with your shipment.

• Microplate Centrifuge Unpacking Guide. Provides unpacking instructions 
for the Centrifuge.

• Microplate Centrifuge Quick Guide. Provides a brief hardware overview 
and instructions on how to start up, shut down, set spin parameters, load 
and unload microplates, and spin the labware.

• Centrifuge Diagnostics Version 8 Quick Reference. Provides a reference to 
the controls and indicators in Centrifuge Diagnostics.

• Microplate Centrifuge ActiveX v8 User Guide. Describes the ActiveX 
controls for the Microplate Centrifuge.

• VWorks Automation Control Setup Guide. Explains how to define labware 
and labware classes, liquid classes, and pipetting techniques, and how to 
track and manage labware in storage.

• VWorks Automation Control User Guide. Explains how to create protocols, 
and set task parameters for each device in the system.

For devices in a third- party system, see the relevant third- party system guides.

Related information

Included a description of how to add the 
Centrifuge device to a VWorks device file.

“Creating and editing device 
files” on page 34

Updated all diagnostics procedures based 
on Centrifuge Diagnostics version 8.0.

“Creating and editing profiles” on 
page 40

“Setting the bucket home 
position” on page 45

“Performing a spin” on page 57

Added a procedure for changing the fuse. “Replacing the fuse” on page 79

Updated the troubleshooting topic “Troubleshooting hardware 
problems” on page 81

Feature and description See…

For more information about... See...

Accessing product user guides “Accessing Agilent Automation Solutions 
user information” on page viii

Reporting problems “Reporting problems” on page 84
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Accessing Agilent Automation Solutions user information

About this topic

This topic describes the different formats of user information and explains how 
to access it for the Agilent Automation Solutions products.

Where to find user information

The Automation Solutions user information is available in the following 
locations:

• Knowledge base. The help system that contains information about all the 
Automation Solutions products is available from the Help menu within the 
VWorks software. 

• PDF files. The PDF files of the user guides are installed with the VWorks 
software and are on the software CD that is supplied with the product. A 
PDF viewer is required to open a user guide in PDF format. You can 
download a free PDF viewer from the internet. For information about using 
PDF documents, see the user documentation for the PDF viewer.

• Agilent website. You can search the online knowledge base or download the 
latest version of any PDF file from the Agilent website at www.agilent.com/
chem/askb. 

Accessing safety information

Safety information for the Automation Solutions devices appears in the 
corresponding device safety guide or user guide.

You can also search the knowledge base or the PDF files for safety information.

Using the knowledge base

Knowledge base topics are displayed using web browser software such as 
Microsoft Internet Explorer and Mozilla Firefox.

Note: If you want to use Internet Explorer to display the topics, you might 
have to allow local files to run active content (scripts and ActiveX controls). To 
do this, in Internet Explorer, open the Internet Options dialog box. Click the 
Advanced tab, locate the Security section, and select Allow active content to run in 
files on my computer.

To open the knowledge base, do one of the following:

• From within VWorks software, select Help > Knowledge Base or press F1.

• From the Windows desktop, select Start > All Programs > Agilent Technologies > 
VWorks > User Guides > Knowledge Base.

http://www.agilent.com/chem/askb
http://www.agilent.com/chem/askb
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Opening the help topic for an area in the VWorks window

To access the context-sensitive help feature:

1 In the main window of the VWorks software, click the help button . 

The pointer changes to . Notice that the different icons or areas are 
highlighted as you move the pointer over them.

2 Click an icon or area of interest. The relevant topic or document opens. 
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Features in the Knowledge Base window

 

Item Feature

1 Navigation area. Consists of four tabs:

• Contents. Lists all the books and the table of contents of the 
books.

• Index. Displays the index entries of all of the books.

• Search. Allows you to search the Knowledge Base (all products) 
using keywords. You can narrow the search by product.

• Favorites. Contains bookmarks you have created.

2 Navigation buttons. Enable you to navigate through the next or 
previous topics listed in the Contents tab.

3 Content area. Displays the selected online help topic.

4 Toolbar buttons. Enable you to print the topic or send documentation 
feedback by email.
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1
Safety guidelines

This chapter contains the following topics:

• “General safety information” on page 2

• “Safety and regulatory compliance” on page 3

• “Mechanical hazards” on page 5

• “Potential equipment damage” on page 6
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General safety information

Before installing and using the Centrifuge

Before using the Centrifuge, make sure that you are properly trained in:

• General laboratory safety

• The correct and safe operation of the Centrifuge

• The correct and safe operation of lab automation systems or components 
used in combination with the Centrifuge

General safety precautions

For general safety precautions, intended product use statement, and the list of 
safety labels, see the Automation Solutions Products General Safety Guide. 

Note: If the Centrifuge is installed in a BioCel System, see the BioCel System 
Safety Guide.

Related information

For information about... See...

Safety and regulatory compliance “Safety and regulatory compliance” on 
page 3

Mechanical hazards “Mechanical hazards” on page 5

Cautions about potential equipment 
damage

“Potential equipment damage” on 
page 6
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Safety and regulatory compliance

The Centrifuge complies with the applicable EU Directives and bears the CE 
mark. See the Declaration of Conformity or Declaration of Incorporation, as 
applicable, for details. The Centrifuge is designed to comply with the 
regulations and standards listed in the following table. 

Electromagnetic compatibility
If the Centrifuge causes interference with radio or television reception, which 
can be determined by turning the device off and on, try one or more of the 
following measures:

• Relocate the radio or television antenna.

• Move the device away from the radio or television.

• Plug the device into a different electrical outlet, so that the device and the 
radio or television are on separate electrical circuits.

• Make sure that all peripheral devices are also certified.

• Make sure that appropriate cables are used to connect the device to 
peripheral equipment.

• Consult your equipment dealer, Agilent Technologies, or an experienced 
technician for assistance.

Changes or modifications not expressly approved by Agilent Technologies could 
void the user's authority to operate the equipment.

Sound emission declaration
Sound pressure: Lp < 70 dB according to EN ISO 779:2010.

Schalldruckpegel: Lp < 70 dB nach EN ISO 779:2010.

Regulatory Compliance Standard

EMC

European Union EMC Directive 2004/108/EC

IEC 61326- 1:2005 / EN 61326- 1:2006

Canada ICES/NMB- 001:2004

Australia/New Zealand AS/NZS CISPR 11:2004

Safety

European Union Machinery Directive 2006/42/EC

Low Voltage Directive 2006/95/EC

IEC 61010- 1:2001 / EN61010- 1:2001

IEC 61010- 2- 081:2001+A1:2003 /

EN 61010- 2- 081:2002+A1:2003

Canada CAN/CSA- C22.2 No. 61010- 1- 04

CAN/CSA- C22.2 No. 61010- 2- 081- 04

USA ANSI/UL 61010- 1:2004
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South Korean Class A EMC declaration

This equipment is Class A suitable for professional use and is for use in 
electromagnetic environments outside of the home.

Related information

For information about... See...

General precautions, intended 
product use statement, and list of 
safety labels

Automation Solutions Products 
General Safety Guide

Mechanical hazards “Mechanical hazards” on page 5

Cautions about potential equipment 
damage

“Potential equipment damage” on 
page 6
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Mechanical hazards

The Centrifuge will not spin unless:

• The door is closed and locked.

• The buckets are unlocked.

• The bucket payloads are balanced.

• The appropriate software command is sent.

The Centrifuge automatically closes and locks the door whenever you start a 
spin cycle. The Centrifuge door will not unlock or open if the rotor is moving.

Figure Centrifuge door

 

WARNING  Do not attempt to manually unlock the door while the rotor is moving. 
Although no longer powered, the buckets might still be rotating at a dangerous speed.

WARNING  Keep away from the Centrifuge while it is in motion. Not all circumstances 
can be foreseen and serious injury is possible. It is the responsibility of every operator to 
follow warnings and safety labels.

WARNING  Keep away from the Centrifuge door while it is opening or closing. The 
Centrifuge door can cause possible pinching, piercing, or bruising if your hand is in the 
opening when it closes.

00077
VSpin
front

Centrifuge

WARNING  Do not operate the Centrifuge if any of its components or accessories are 
damaged or have been modified in any manner not authorized by Agilent Technologies. Do 
not operate the Centrifuge if objects or liquids are trapped within the chamber. Discontinue 
use if the Centrifuge vibrates or emits noise above normal levels.

WARNING  Each Centrifuge bucket can hold a microplate or counterweight that 
weighs up to 250 g (8.82 oz). Placing heavier microplates or counterweights in the 
Centrifuge can cause the device to malfunction during operation, damaging the device and 
causing severe injury. 

WARNING  Do not operate the Centrifuge above speeds of 1500 RPM unless it is 
securely mounted to a structure approved by Agilent Technologies.
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Related information

Potential equipment damage

Related information

For information about... See...

General precautions, intended 
product use statement, and list of 
safety labels

Automation Solutions Products 
General Safety Guide

Safety and regulatory compliance “Safety and regulatory compliance” on 
page 3

Cautions about potential equipment 
damage

“Potential equipment damage” on 
page 6

CAUTION Dirt in unfiltered air can build up in the Centrifuge air valves and can eventually 
cause a malfunction. Ensure that the air supply is properly filtered for moisture and aerosol 
impurities. 

CAUTION Trapped liquids in the Centrifuge may cause corrosion inside the device.

CAUTION Use only the recommended cleaning materials. Using other cleaning solutions 
and materials can cause damage to the device. Do not use abrasive, corrosive cleaning 
agents. Do not use metal brushes.

CAUTION If labware breaks apart inside the Centrifuge, ensure that all the fragments are 
removed. Labware fragments can interfere with moving parts and potentially damage the 
Centrifuge.

CAUTION The Centrifuge has a permanently attached rotor. Tampering with or adjusting 
the rotor mounting screw, which fastens the rotor to the central motor axle, can result in 
equipment damage. If you think the rotor mounting screw requires maintenance, contact 
Agilent Automation Solutions Technical Support.

For information about... See...

General precautions, intended 
product use statement, and list of 
safety labels

Automation Solutions Products 
General Safety Guide

Mechanical hazards “Mechanical hazards” on page 5

Safety and regulatory compliance “Safety and regulatory compliance” on 
page 3
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2
Introduction

This chapter provides an overview of the Centrifuge. The topics 
are:

• “About the Centrifuge” on page 8

• “Hardware overview” on page 9

• “Connection panel” on page 10

• “Software overview” on page 11
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About the Centrifuge

Introduction

The Agilent Microplate Centrifuge is a robot- accessible automated centrifuge 
that is intended to be integrated with a robotic lab automation system, such as 
the BioCel Automation System. 

The Centrifuge has two buckets, each capable of carrying a single microplate, 
filter plate, or lidded microplate.

The microplates in the two buckets must be balanced to within 10 grams of 
each other. You can pair one sample plate with another of equal weight, or you 
can pair a sample plate with a balance plate that has been equally weighted 
with water.

About the Automated Centrifuge Loader

Not all robots can access the Centrifuge directly. For example, a crane- style 
robot can pick and place plates vertically, but cannot move a plate horizontally 
through the Centrifuge door. 

To enable plate placement by these robots, the Centrifuge can be paired with 
the Agilent Centrifuge Loader. The Centrifuge Loader has a plate stage and a 
gripper. After the robot places a plate onto the plate stage, the gripper picks 
up the plate and moves it into the Centrifuge. 

Related information

For information about... See...

Safety guidelines “Safety guidelines” on page 1

Centrifuge hardware components “Hardware overview” on page 9

Initializing the Centrifuge “Initializing the device profile and 
checking status” on page 42

Spinning microplates “Workflows for performing spins” on 
page 58

Automated Centrifuge Loader Microplate Centrifuge with Loader 
User Guide
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Hardware overview

Front features

The Centrifuge door is at the front of the device. The door opens to permit you 
to load and unload microplates. The door closes and locks before a spin cycle 
starts. 

Figure Door at the front of the Centrifuge

Inside the Centrifuge are two buckets that host microplates and 
counterweights. The following figure shows a close- up view of the buckets. 

Note: Only one bucket is visible from the doorway.

Figure Buckets inside the Centrifuge

Related information
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VSpin
front

Centrifuge
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front

CentrifugeCentrifuge

00108
VSpin
Rotor assembly - bucket rotated

00
10

8

For information about... See...

Safety guidelines “Safety guidelines” on page 1

Initializing the Centrifuge “Initializing the device profile and 
checking status” on page 42

Spinning microplates “Workflows for performing spins” on 
page 58
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Connection panel

The following figure and table describe the connection panel on the rear of the 
Centrifuge.

Figure Centrifuge connection panel

Related information

00079
VSpin
back

1 2 3 4 5

Item Part Comment

1 Serial port (DB- 9 
RS- 232 9- pin)

Connects a serial cable from the controlling 
computer to the Centrifuge to provide 
communication.

2 Air supply port Connects to a compressed- air source. The 
Centrifuge uses compressed air to move 
components, such as opening and closing the 
Centrifuge door.

3 AC power entry Connects the power cord.

4 Power switch Turns on ( I ) and off ( O ) the device 
power.

5 Fuse panel Houses the AC inlet fuse.

For information about... See...

Specifications for air supply, power, 
and fuse

“Laboratory requirements” on page 15

Connecting the communication 
cable, air line, and power cord

“Connecting the device” on page 27

Initializing the Centrifuge “Initializing the device profile and 
checking status” on page 42
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Software overview

About this topic

This topic describes the software that you use to operate the Centrifuge.

• “Centrifuge Diagnostics software” on page 11

• “About labware automation software” on page 11

• “VWorks software” on page 12

• “Centrifuge ActiveX control” on page 12

Centrifuge Diagnostics software

The Centrifuge Diagnostics software enable you to:

• Set up the Centrifuge device for automated operation. The setup requires a 
device profile. A Centrifuge device profile specifies the:

– Serial communication connection (COM port) with the controlling 
computer. 

– The bucket home positions. The home position is the location to which 
the rotor turns to line up a bucket with the door. 

• Spin individual microplates without running a protocol.

• Diagnose problems. You can view status information and move Centrifuge 
components to diagnose and troubleshoot problems.

About labware automation software

You can use either the VWorks software or third- party automation software to 
operate the Centrifuge in protocol runs. If you plan to use third- party 
automation software, you use the Centrifuge ActiveX control to permit the 
software to interface with the device.
                                                        

Safety guidelines “Safety guidelines” on page 1

For information about... See...
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VWorks software

The VWorks software enables you to:

• Set up the Centrifuge. You create a device file for the Centrifuge, and then 
you open Centrifuge Diagnostics to complete the device setup.

• Set up user accounts and privileges. You can set up different user accounts 
to enforce access policies. 

• Define labware. Labware definitions describe the labware you will use 
during protocol runs.

• Create protocols. Protocols determine the sequence of tasks you want to 
automate in a run. 

• Run, pause, monitor, and stop protocols. You can start, pause, monitor, and 
stop a protocol run from the controlling computer. 

Centrifuge ActiveX control

Instead of using the VWorks software, you can use another automation control 
software to operate the Centrifuge in protocol runs. The Centrifuge ActiveX 
control allows automation software to interface with the device.

Related information

For information about... See...

Setting up the VWorks software, 
including defining labware

VWorks Automation Control Setup 
Guide

Setting up in the Centrifuge “Setup workflow” on page 32

Centrifuge Diagnostics • “Using Centrifuge Diagnostics to 
perform a spin” on page 65

• Centrifuge Diagnostics v8 Quick 
Reference

How to use the VWorks software to 
run a protocol

• “Workflow for running a protocol” 
on page 58

• VWorks Automation Control User 
Guide

Centrifuge ActiveX controls Microplate Centrifuge ActiveX v8 User 
Guide
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3
Installing the Centrifuge

This chapter describes how to install and set up the Centrifuge. 

IMPORTANT The procedures in this chapter are intended for 
personnel properly trained in the installation of such hardware.

• “Installation workflow” on page 14

• “Laboratory requirements” on page 15

• “Performance specifications” on page 19

• “Labware specifications” on page 20

• “Mounting the Centrifuge” on page 22

• “Installing the buckets” on page 25

• “Connecting the device” on page 27
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Installation workflow

To install the Centrifuge, perform the following procedures in the order listed.

Step Procedure See...

1 Verify that the installation 
site meets the requirements.

“Laboratory requirements” on page 15

2 Unpack the Centrifuge. Microplate Centrifuge Unpacking 
Guide 

3 Install the buckets. “Installing the buckets” on page 25

4 Mount the Centrifuge on the 
laboratory table.

“Mounting the Centrifuge” on page 22

5 Connect the air and power 
sources and the computer to 
the Centrifuge.

“Connecting the device” on page 27

6 Install the automation control 
software.

VWorks Automation Control Setup 
Guide or the software release notes
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Laboratory requirements

About this topic

This topic describes the requirements for the site where you plan to install the 
Centrifuge.

Laboratory space requirements

Ensure that the installation location meets the following requirements:

• Provides proximity to the power outlet and air source.

• Allows sufficient space to accommodate the device and provide clearance 
at the back of the device to access power, communication, and air tubing 
connections.

Lab bench or table requirements
Make sure the lab bench of table meets the following requirements:

• Sufficient space to accommodate the device and provide clearance at the 
back of the device to access power, communication, and air tubing 
connections.

• Proximity to power outlet and air source.

• A fixed table (without wheels or with locking casters) that can support the 
weight of the device without excessive shaking or movement:

– For centrifuge speeds above 1500 RPM, or when an immovable position 
is required, use a table that meets the following specifications at a 
minimum:

Table surface thickness: 1.3 cm (0.5 in) 

Table weight: 45.5 kg (100 lb) 

– For centrifuge speeds below 1500 RPM and when a consistent location 
is not required, use a table that meets the following specification for 
free- standing operation:

Table with non- skid stable surface: 36 x 49 cm (14 x 19 in)

• Proper height for any operator to comfortably operate the device.
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Physical dimensions
The following figure and table provide the Centrifuge dimensions. 

Figure Centrifuge dimensions: front view and top view

Device orientation considerations
The following figures and table provide the dimensions of the Centrifuge door 
and the position of the buckets so that you can set up your robot to access the 
Centrifuge buckets properly. 

For an illustration of the mounting holes, see “Preparing the mounting surface 
for installation” on page 22.

Figure Centrifuge front door dimensions (front view with door open)

00071
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Bucket position

45.8 cm

00074
Vspin
door dimensions

Centrifuge

20.0 cm

32.7 cm

Dimension Value

Height 20.0 cm (8.09 in) 

Width 32.7 cm (12.9 in)

Depth 45.8 cm (18.1 in)

Weight 26.1 kg (57.5 lb)

00074
Vspin
door dimensions

Centrifuge

14.4 cm

6.86 cm

16.5 cm
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The following figure and table provide labware entry dimensions

Figure Centrifuge labware entry dimensions (front view)

Figure Centrifuge bucket in the load/unload position (top view)

00074
Vspin
door dimensions

Centrifuge

6.74 cm

4.98 cm

12.8 cm

4.62 cm

1

2

4

5

3

6.38 cm

Item Dimension Value

1 Distance from front door top edge to bucket 
surface

6.74 cm (2.65 in)

2 Distance from bucket surface to Centrifuge 
bottom mounting surface

4.62 cm (1.82 in)

3 Bucket width 12.8 cm (5.04 in)

4 Distance from front door top edge to top of 
front bucket tabs

6.38 cm (2.51 in)

5 Distance from Centrifuge bottom mounting 
surface to top of bucket tabs

4.98 cm (4.98 in)

00071
Vspin
Bucket position

00
07

1

8.66 cm 5.94 cm

Front
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Electrical requirements

The Centrifuge has the following power requirements.

Compressed air requirements

The Centrifuge requires the use of clean, dry, compressed air to move the 
pneumatic components. The compressed air can be from the following sources:

• Centralized source (laboratory)

• Compressed- air cylinders

• Portable pumps

The minimum compressed- air requirements are:

Environmental requirements

Ambient environment
The Centrifuge is for indoor use only. The following table lists the operating 
specifications.
 

Requirement Value

Electrical 100~ to 240~, 50/60 Hz

Fuse 7 A, 250 V, 3 AG

CAUTION Ensure that the air coming into the device is properly filtered from moisture or 
aerosolized impurities. Significant moisture or impurities in the air line can adversely affect 
the performance and life of the device. Using oil compressors can cause oil to leak into the 
device and void your warranty.

Requirement Value

Quality Clean, dry, compressed

Flow rate and pressure 0.5 Lps at 550 kPa (1 cfm at 80 psi)

Requirement Value

Pollution degree 2

Installation category II

Temperature 5 to 40 °C

Humidity condition 10- 90% RH, non- condensing

Elevation 1–2000 m
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Computer requirements

The Centrifuge has a DB- 9 RS- 232 9- pin serial port for serial communication 
with the controlling computer.

Additional requirements depend on the lab automation software you are using:

• For VWorks software computer requirements, see the VWorks software 
release notes or the VWorks Knowledge Base at 
www.agilent.com/chem/askb

• For third- party automation software requirements, see the user 
documentation supplied with the product.

Related information

Performance specifications

The following table provides the Centrifuge performance specifications.

For more information about... See...

Installation workflow “Installation workflow” on page 14

Performance specifications “Performance specifications” on 
page 19

Labware requirements “Labware specifications” on page 20

Safety guidelines “Safety guidelines” on page 1

Property Value

Spindle speed 0–3000 RPM

Maximum centrifugal force 
on plate

1000 xg

Maximum imbalance 10 grams

If you require a higher balance tolerance, 
contact Agilent Automation Solutions Technical 
Support. 

Maximum mass of each 
plate

250 grams

Acceleration 0–2000 RPM in 5.0 seconds

0–3000 RPM in 7.5 seconds

Deceleration 2000–0 RPM in 5.0 seconds

3000–0 RPM in 7.5 seconds

http://www.agilent.com/chem/askb
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Related information

Labware specifications

The Centrifuge is designed for labware that comply with the standards ANSI/
SLAS 1- 2004 (R2012) through ANSI/SLAS 4- 2004 (R2012). Carefully evaluate 
any labware before use. If you have questions, contact your Agilent 
representative for evaluation. 

The overall labware dimensions, including a lid, must fit within the following 
values. 

• Width: 12.8 cm (5.03 in)

• Depth at base: 8.6 cm (3.38 in) 

• Depth above base and height: 

– 8.6 cm (3.38 in) up to 4.0 cm (1.57 in)

– 7.8 cm (3.07 in) up to 4.8 cm (1.89 in)

The maximum height specification varies based on the depth measurement 
above a height of 4.0 cm, as the following figure shows.

Figure Labware maximum height based on depth

For more information about... See...

Laboratory requirements “Laboratory requirements” on page 15

Installation workflow “Installation workflow” on page 14

Labware specifications “Labware specifications” on page 20

Safety guidelines “Safety guidelines” on page 1

4.8 cm 

Maximum
Height

4.0 cm 
8.6 cm
DepthMaximum

Height

7.8 cm
Depth

CAUTION Even if a microplate will fit through the Centrifuge door, an oversized microplate 
can cause a collision during a spin cycle when the buckets are tilted. Ensure that the 
microplate and lid, if applicable, fit within the specified depth profile.
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Figure Depth profile (A) labware that fits within the profile and (B) labware that does not fit the profile

In example A, the microplate is 4.8- cm tall and has a 8.6- cm skirt depth, but 
the upper portion of the microplate fits within the 7.8- cm specification.

In example B, the microplate has a lid. The depth of the top of the lid (8.6 cm) 
exceeds the 4.0 cm maximum height. This microplate with lid might fit through 
the Centrifuge door and into the bucket. However, during a spin cycle when 
the buckets are tilted, the top corners of the lid would collide with the 
Centrifuge rotor, potentially resulting in equipment damage.
 

Related information

4.0 cm
Height

8.6 cm
Depth

4.8 cm 

7.8 cm

Depth

Height

A B

For more information about... See...

Installation workflow “Installation workflow” on page 14

Laboratory requirements “Laboratory requirements” on page 15

Performance specifications “Performance specifications” on 
page 19

Safety guidelines “Safety guidelines” on page 1



3   Installing the Centrifuge
Mounting the Centrifuge

22 Microplate Centrifuge User Guide

Mounting the Centrifuge

Before you start

The procedures in this topic assume that you have experience in working on 
mechanical equipment that includes components sensitive to electrostatic 
discharge (ESD).

Ensure that you have a Hex wrench, 2.5 mm.

Note: The Centrifuge includes four M6 X 30 flathead screws for mounting the 
device. You may need to obtain screws that are a more suitable length for your 
particular laboratory setup.

About installing the Centrifuge

In order for your robot to move plates to and from the Centrifuge buckets, the 
three- dimensional position of the buckets must be fixed and known to the 
controlling software of the lab automation system. To accomplish this, the 
Centrifuge must be mounted on a stable base that does not move in relation to 
the robot.

You can mount the Centrifuge directly on a tabletop or on a mounting plate 
that also holds other components of your system. You should have the surface 
accurately drilled and tapped to create screw holes, according to the 
dimensions given in this topic.

Preparing the mounting surface for installation

To prepare your mounting surface for installation:
Prepare the mounting holes to accommodate the Centrifuge using the following 
figures for reference.

Use a #9 drill bit with an M6 tap to prepare the holes.

WARNING Touching the circuit board when the power is on could give you an electrical 
shock. Ensure that the Centrifuge is not connected to a power source for this procedure.

CAUTION The electronic components inside the Centrifuge are sensitive to static 
electricity. To prevent potential damage, wear a grounded wrist strap and avoid contact with 
the electronic components. 

CAUTION Dropping or bumping the Centrifuge or the buckets can damage the device and 
result in further damage during a Centrifuge spin cycle. If the Centrifuge is subjected to a 
forceful impact, do not use the device until it is safe to operate. If you have questions about 
potential equipment damage, contact Automation Solutions Technical Support.
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Figure Centrifuge mounting holes (bottom view)

Mounting the Centrifuge to a stable surface

Ensure that you have prepared the Centrifuge mounting surface. 

To mount the Centrifuge to a stable surface:

1 Remove the front and back Centrifuge covers, using the following figure for 
reference.

Four retention screws and washers attach the front and back covers. Use a 
2.5- mm hex wrench to remove the screws.

Figure Locations of attachment screws for front and back cover removal
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shroud removal
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2 Carefully, lift the Centrifuge and place it on the bench so that the screw 
holes in the Centrifuge base align with the screw holes in your tabletop.

All holes accommodate M6 flathead cap screws. 

3 Screw one M6 flathead screw into a front screw hole, and another into the 
diagonally opposed screw hole on the rear, making sure that both screw 
completely into the base.

Gently nudge the Centrifuge back and forth as you install the screws to 
ensure that the Centrifuge screw holes are seated squarely over the screw 
holes in the mounting surface.

Tighten the front screw before tightening the rear screw.

4 Install the other two screws into the screw holes, making sure they screw 
completely into the base.

5 Verify that the Centrifuge is firmly seated to your mounting surface.

If the Centrifuge moves, loosen the screws and repeat step 3 and step 4 to 
retighten the screws.

6 To re- install the covers:

a Position the rear cover, aligning the side screw holes.

b Position the front cover on the front of the Centrifuge.

c Install the four retention screws and washers: two screws and washers 
at the rear, and one screw and washer on each side, as the preceding 
figure shows.

IMPORTANT Ensure that the round surface of each washer is facing 
the cover.

Related information

For more information about... See...

Site requirements “Laboratory requirements” on page 15

Installation workflow “Installation workflow” on page 14

Safety guidelines “Safety guidelines” on page 1
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Installing the buckets

About this topic

The buckets are packaged in their own box to minimize damage to the 
Centrifuge during shipment. This topic describes how to install the buckets in 
the Centrifuge. 

Before you start

Manually open the Centrifuge door. For instructions, see “Unlocking and 
opening the door manually” on page 73.

Procedure

To install or replace a bucket:

1 Ensure that the rotor is positioned so that the bucket pins are centered in 
the open doorway. 

If necessary, manually rotate the rotor to align it as the following figure 
shows.

2 Pass the bucket through the open door as the following figure shows.

Figure Open door showing (1) rotor pin, (2) bucket hanger, and (3) rear tab

3 Roll the bucket right- side- up so that the bucket hangers are seated onto 
the rotor pins. 

You may need to align one hanger on a rotor pin, and then adjust the 
position before you can align the second hanger onto the other rotor pin.

4 Ensure that the bucket tabs are facing up, and that the rear tabs are 
towards the rotor, as the following figure shows.

00112
VSpin
bucket insertion

1

2
3
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5 Push the bucket onto the pins until the bucket seats snugly and can pivot 
freely.

Figure Detail of buckets seated on rotor pins

 

Related information
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For more information about... See...

Site requirements “Laboratory requirements” on page 15

Installation workflow “Installation workflow” on page 14

Safety guidelines “Safety guidelines” on page 1
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Connecting the device

Before you start

• Make sure the laboratory setup requirements have been met. See 
“Laboratory requirements” on page 15.

• Ensure that the computer and Centrifuge are turned off.

• Make sure you have the supplied serial cable, power cord, and air 
connection kit, including tubing and fittings.

Connecting to the air source

This section includes procedures for both:

• Non- metric- based installations, such as those in the US

• Metric- based installations

The following procedure is for a direct connection. If you have another 
instrument connected to the house air supply, you can use the supplied 
T-connector to connect into the existing air tubing.

To install the compressed air line (non-metric):

1 Turn off the air supply before connecting the air tubing to the Centrifuge.

2 Cut the supplied tubing to the required length.

3 Connect one end of the tubing to the air source.

4 If your air line uses a threaded port, attach the 0.25- in NPT fitting to the 
port. Attach the 0.25- in one- touch hose fitting into the 0.25- in tubing.

5 Plug the other end of the 0.25- in tubing into the one- touch air- supply port 
on the back of the Centrifuge.

6 Test the installation by gently tugging the air tubing.

If you feel resistance, the line has been properly installed. If the tubing 
comes free, it needs to be inserted with more force.

WARNING  Working with open, charged air lines can result in injury. Turn off the 
compressed air line when disconnecting or reconnecting devices that use compressed air. 
Contact your facilities department or Agilent Automation Solutions Technical Support with 
questions about setting up the air line.

CAUTION Dirt in unfiltered air can build up in the Centrifuge air valves and can eventually 
cause a malfunction. Ensure that the air supply is properly filtered for moisture and aerosol 
impurities. 
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Figure Air line connection

 

To install the compressed air line (metric)

1 Push one end of the nipple (white plastic tube) into the 0.25- in side (red 
side) of the adapter.

2 Push the other end of the nipple into the air input port on the Centrifuge.

3 Push the 6- mm tubing into the blue side of the adapter.

4 Gently pull on the air tubing to ensure that the assembly is connected 
properly.

Connecting the power cord

To connect the power cord to the Centrifuge:

1 On the back of the Centrifuge, ensure that the power switch is set to off 
( O ).

2 Connect one end of the power cord to the AC power entry on the back of 
the Centrifuge.

3 Connect the other end of the power cord to an AC outlet with a grounded 
circuit.

                                                        

00080
VSpin
attach air hose

CAUTION Attempting to use tubing that has a different diameter can damage the 
adapter.
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Connecting the computer

To connect the Centrifuge to the computer:

1 Connect one end of the supplied serial communications cable to the serial 
interface on the back of the Centrifuge.

2 Connect the other end of the serial communications cable to a serial 
communications port on the controlling computer.

Make a note of the COM port number. You will provide the number when 
creating a device profile in Centrifuge Diagnostics.

Related information

00079
VSpin
back

For more information about... See...

Site requirements “Laboratory requirements” on page 15

Installation workflow “Installation workflow” on page 14

Safety guidelines “Safety guidelines” on page 1
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4
Setting up the Centrifuge

This chapter contains the following topics:

• “Setup workflow” on page 32

• “Starting up and shutting down” on page 33

• “Creating and editing device files” on page 34

• “Opening Centrifuge Diagnostics” on page 38

• “Creating and editing profiles” on page 40

• “Initializing the device profile and checking status” on page 42

• “Setting the bucket home position” on page 45
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Setup workflow

Perform the following procedures in the order listed to set up the Centrifuge.

Step Procedure See...

1 Turn on the Centrifuge. “Starting up and shutting down” on 
page 33

2 In the VWorks software, 
create a device file and add 
the Centrifuge device.

“Creating and editing device files” on 
page 34

3 Open Centrifuge Diagnostics. “Opening Centrifuge Diagnostics” on 
page 38

4 Create a profile and select 
the profile in the Centrifuge 
device.

“Creating and editing profiles” on 
page 40

5 Set the bucket home position 
so that it lines up with the 
door.

“Setting the bucket home position” on 
page 45

6 Set the teachpoint for your 
robot to pick and place 
labware in the Centrifuge.

User documentation for the external 
robot

7 Verify that you can perform a 
spin using Centrifuge 
Diagnostics.

“Performing a spin” on page 57
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Starting up and shutting down

Starting up the Centrifuge

To start up the Centrifuge:

1 Verify that the air supply is turned on.

2 Turn on the computer and the monitor. Wait for the Microsoft Windows 
operating system to finish starting up.

3 On the back of the Centrifuge, press the power switch to the on (I) 
position.

Figure Power switch on the back of the Centrifuge

 

4 Start the VWorks software.

5 In the VWorks software, turn off the simulation mode.

6 To establish communication with the Centrifuge, initialize the Centrifuge 
device. For details, see “Initializing the device profile and checking status” 
on page 42.

If you have not yet created a device file or configured the device profile for 
your setup, see “Creating and editing profiles” on page 40.

Shutting down the Centrifuge

To shut down the Centrifuge:

1 Remove any microplates or counterweight from the Centrifuge. For 
unloading instructions, see “Loading and unloading microplates and 
counterweights” on page 62.

2 Close the Centrifuge Diagnostics dialog box.

3 In the VWorks window, select the Centrifuge device in the device file, and 
then click Close selected devices.

4 Exit the VWorks software, and then shutdown the computer.

5 On the back of the Centrifuge, press the power switch to the off position 
(o).

00079
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back



4   Setting up the Centrifuge
Creating and editing device files

34 Microplate Centrifuge User Guide

6 Turn off the air supply to the Centrifuge.

Related information

Creating and editing device files

About this topic

This topic explains how to create a device file in the VWorks software and how 
to edit the device properties. 

If you already have a device file you want to use, proceed to the following:

• “Adding a Centrifuge to the device file” on page 36 

• “Setting the Centrifuge device properties” on page 36.

Devices and device file defined

What is a device?
A device is an item in your lab automation system that has an entry in the 
VWorks software device file. A device can be a robot, an instrument, or a 
location in the system that can hold a piece of labware. 

What is a device file?
To communicate with and to control the robot and integrated devices, the 
VWorks software uses a device file that contains the following information:

• List of devices the software will communicate with and control

• Profile of each device (communication method, unique device configuration 
information)

For more information about... See...

Initializing the Centrifuge “Initializing the device profile and 
checking status” on page 42

Creating profiles “Creating and editing profiles” on 
page 40

Loading and unloading plates in the 
Centrifuge

“Loading and unloading microplates 
and counterweights” on page 62

Centrifuge Diagnostics “Using Centrifuge Diagnostics to 
perform a spin” on page 65

How to use the VWorks software to 
run a protocol

“Workflow for running a protocol” on 
page 58

VWorks Automation Control User 
Guide
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• System- related configuration information of each device (for example, 
approach height, barcode access, and so on)

You provide the device information in the VWorks software. The device 
information is stored in a device (.dev) file that is located in a folder you 
specify when saving the file.

For detailed information about device files and associations with profiles, 
teachpoint files, and other VWorks components, see the VWorks Automation 
Control User Guide.

Creating a device file

Before you create a device file, start the VWorks software and log in. See the 
VWorks Automation Control User Guide for instructions.

To create a new device file:

1 In the VWorks window, select File > New > Device. A Device File tab appears.

2 Select File > Save to save the device file. The file name appears in the 
Device File tab.
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Adding a Centrifuge to the device file

To add a Centrifuge in the device file:

1 In the Available Devices area, double- click the Centrifuge device icon, or drag 
the icon from the Available Devices area into the Device File area.

Notice that in the Devices area, the first Centrifuge device is labeled 
Centrifuge- 1. If you add another Centrifuge device, it will appear as 
Centrifuge- 2.

Note: If you do not see the Centrifuge in the Available Devices list, check 
that the plugin file (AgilentCentrifuge.dll and AgilentCentrifuge 
Loader.dll, if applicable) is stored in the following folder: 

\Agilent Technologies\VWorks\Plugins

If you have added the Centrifuge plugin file in the Plugins folder and 
started the VWorks software, and still do not see the Centrifuge in the 
Available Devices list, close any open device files and protocol files, and 
then select Tools > Reload Plugins.

Setting the Centrifuge device properties

To set the Centrifuge properties:

1 In the Centrifuge Properties area of the device file, type or select the 
following:

Property Description

Name The name of the Centrifuge.
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2 In the Devices area, expand Centrifuge, and then select Bucket 1.

3 In the Centrifuge Location Properties area, set the following parameters:

4 Repeat steps 2 and 3 to set the properties for the Bucket 2.

5 Select File > Save to save the device file.

Related information

Profile The profile associated with the device.

Select the desired profile from the list. If the profile 
you want does not appear in the list, or if no 
profile appears in the list, see “Creating and editing 
profiles” on page 40, and then return to this step to 
select the profile.

IMPORTANT Without the profile, you will not be 
able to establish communication with the device.

Property Description

Parameter Description

Allow/prohibited 
labware

Permitted labware class for the selected location.

Use this field only if you want to limit the labware 
types. For details on labware classes, see the VWorks 
Automation Control Setup Guide.

BCR on south/
west/north/east 
side

The location of the barcode reader and the desired 
barcode reader device.

Use this field only if a barcode reader is installed on 
the device.

Use for deadlock 
avoidance

The option to permit the location to be used for 
deadlock avoidance.

Select Yes to permit labware to be moved to this 
location to avoid a deadlock in the system.

Select No if you do not want to move random 
labware to this location to avoid deadlock.

IMPORTANT For typical operation, select No for the 
Centrifuge.

Door Not applicable

For more information about... See...

Initializing the Centrifuge “Initializing the device profile and 
checking status” on page 42

Creating profiles “Creating and editing profiles” on 
page 40

Loading and unloading plates in the 
Centrifuge

“Loading and unloading microplates 
and counterweights” on page 62
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Opening Centrifuge Diagnostics

Procedure

To open Centrifuge diagnostics:

1 In the VWorks window, ensure that the device file is open.

To open the device file, choose File > Open. In the Open dialog box, select 
the *.dev file type, navigate to the device file, and then click Open.

A list of the devices appears in the Device File tab.

2 Select the Centrifuge device, and then click Device diagnostics.

                                                        

Centrifuge Diagnostics “Using Centrifuge Diagnostics to 
perform a spin” on page 65

How to use the VWorks software to 
run a protocol

“Workflow for running a protocol” on 
page 58

VWorks Automation Control User 
Guide

For more information about... See...
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The Centrifuge Diagnostics dialog box opens.

Related information

For more information about... See...

Initializing the Centrifuge “Initializing the device profile and 
checking status” on page 42

Creating profiles “Creating and editing profiles” on 
page 40

Loading and unloading plates in the 
Centrifuge

“Loading and unloading microplates 
and counterweights” on page 62

Centrifuge Diagnostics • “Using Centrifuge Diagnostics to 
perform a spin” on page 65

• Centrifuge Diagnostics Version 8 
Quick Reference

How to use the VWorks software to 
run a protocol

• “Workflow for running a protocol” 
on page 58

• VWorks Automation Control User 
Guide
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Creating and editing profiles

About profiles

A VWorks device profile is a collection of settings that manages how you 
connect to a device. A Centrifuge profile specifies the following:

• COM port used to establish communication between the device and the 
controlling computer.

• The bucket 1 and bucket 2 home positions.

You use the Centrifuge Diagnostics software to create and manage Centrifuge 
profiles.

Note: In the VWorks software, each device in the device file requires a unique 
profile. For information about device files, see “Creating and editing device 
files” on page 34. For a detailed description of the relationships between the 
device file and profile, see the VWorks Automation Control User Guide.

Creating a profile

Before you start, ensure that Simulation is off in the VWorks window, and then 
open Centrifuge Diagnostics.

To create a profile:

1 In the Centrifuge Diagnostics dialog box, click the Profiles tab.

The Profiles tab appears.
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2 Click Create a new profile.

The Create Profile dialog box opens.

3 Type a profile name, and then click OK.

4 Configure the profile settings that you want from the Profiles page.

5 To save the profile settings, click Update this profile.

6 To verify that you can establish communication, initialize the profile. For 
instructions, see “Initializing the device profile and checking status” on 
page 42.

Editing and managing profiles

Editing profiles

To edit a profile:

1 In the Centrifuge Diagnostics Profiles tab, select the profile you want to edit in 
the Profile Management area.

2 Modify the profile information.

3 When you are finished, click Update this profile to save the changes.

Managing profiles
In the Centrifuge Diagnostics Profiles tab, you can select an existing profile, 
and then rename, copy, or delete the profile.

IMPORTANT The bucket home positions (teachpoints) are associated with the 
Centrifuge profile. A copy of an existing profile references the same bucket 
teachpoints.

Related information

Parameter Description

COM port Select the number of the controlling computer 
COM port that is connected to the Centrifuge.

Note: If you are using a USB- to- serial connection, 
you might have to open the Windows Device 
Manager to identify the COM port number.

Bucket 1 teachpoint, 
Bucket 2 teachpoint

You will set these home positions after you 
establish communication with the device. Use the 
default values until you set the teachpoint.

For more information about... See...

Initializing the Centrifuge “Initializing the device profile and 
checking status” on page 42

Loading and unloading plates in the 
Centrifuge

“Loading and unloading microplates 
and counterweights” on page 62
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Initializing the device profile and checking status

About this topic

To establish communication between the computer and the Centrifuge, you 
initialize the Centrifuge device. 

You can initialize the Centrifuge in the following ways:

• Centrifuge Diagnostics. To control the Centrifuge using Centrifuge 
Diagnostics, initialize the profile in Centrifuge Diagnostics.

• VWorks window. To control the Centrifuge from the VWorks window, for 
example, to run a protocol, initialize the device in the VWorks window.

After initializing the device, see “Checking the status” on page 44 to verify that 
the Centrifuge is turned on and communication is established.

Before you start

In the VWorks window, ensure that Simulation is off.

                                                        

Centrifuge Diagnostics “Using Centrifuge Diagnostics to 
perform a spin” on page 65

Centrifuge Diagnostics Version 8 
Quick Reference

How to use the VWorks software to 
run a protocol

“Workflow for running a protocol” on 
page 58

VWorks Automation Control User 
Guide

For more information about... See...
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During initialization, the Centrifuge door closes and locks, the bucket unlocks, 
and the rotor spins to the bucket 1 position. The bucket locks, and the door 
unlocks and opens.

Initializing the profile in Centrifuge Diagnostics

To initialize a profile in Centrifuge Diagnostics:

1 Open the Centrifuge Diagnostics dialog box.

2 In the Profiles tab, ensure that the correct profile is selected in the Profile 
name list.

3 Click Initialize this profile to start initializing the selected profile.

Note: If the device fails to initialize, verify the COM port number in the 
profile. If the problem persists, restart the VWorks software, and if 
necessary, power cycle the device.

Initializing the Centrifuge in the VWorks software

To initialize the device from the VWorks software window:

1 In the VWorks window, choose File > Open. In the Open dialog box, select the 
*.dev file type, navigate to the device file, and then click Open.

A list of the devices appears in the Device File tab.

2 In the Devices area, select the Centrifuge device.

WARNING  Keep away from the Centrifuge door while it is opening or closing. The 
Centrifuge door can cause possible pinching, piercing, or bruising if your hand is in the 
opening when it closes.
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3 In the Centrifuge Properties area, make sure the correct profile is selected.

4 Click Initialize selected devices.

Checking the status

Use the following procedure to check the status indicators in the Centrifuge 
Diagnostics dialog box to make sure that the Centrifuge is turned on.

To check the Centrifuge status:

1 Open Centrifuge Diagnostics.

2 Click the Controls tab. In the Status area, check that the appropriate 
indicator lights are turned on. 
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Related information

Setting the bucket home position

About this topic

After you have set up and turned on the Centrifuge, you set the bucket home 
position to align with the door so that your robot gripper can place labware 
onto the buckets. 

Before you start

Perform the following workflow in the order given.

For more information about... See...

Creating profiles “Creating and editing profiles” on 
page 40

Loading and unloading plates in the 
Centrifuge

“Loading and unloading microplates 
and counterweights” on page 62

Centrifuge Diagnostics • “Using Centrifuge Diagnostics to 
perform a spin” on page 65

• Centrifuge Diagnostics Version 8 
Quick Reference

How to use the VWorks software to 
run a protocol

• “Workflow for running a protocol” 
on page 58

• VWorks Automation Control User 
Guide

WARNING  Keep away from the Centrifuge door while it is opening or closing. The 
Centrifuge door can cause possible pinching, piercing, or bruising if your hand is in the 
opening when it closes.

CAUTION If the bucket lock is extended when a bucket is misaligned, turning the rotor 
manually could cause the rotor or the bucket to collide with the bucket lock and damage the 
bucket, rotor or bucket lock. Ensure that the air supply is turned off before manually rotating 
the rotor.

Step For this task... See...

1 Start up the Centrifuge. “Starting up and shutting down” on 
page 33

2 In Centrifuge Diagnostics, 
initialize the profile that you 
want to use.

“Initializing the device profile and 
checking status” on page 42
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Preparing to set the bucket teachpoints

To prepare for teaching the bucket 1 position:

1 Open Centrifuge Diagnostics, and in the Profiles tab, select and initialize the 
profile.

2 Click Teach bucket 1 position. 

Figure Profiles tab

The Teach Bucket Position 1 dialog box opens.

3 Prepare to teach the bucket 
positions.

“Preparing to set the bucket 
teachpoints” on page 46

4 Set the bucket 1 position 
teachpoint.

“Setting the bucket 1 teachpoint” 
on page 48

5 Set the bucket 2 position 
teachpoint.

“Setting the bucket 2 teachpoint” 
on page 50

Step For this task... See...
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Figure Teach Bucket 1 Position dialog box

3 Turn off the air supply to the Centrifuge. 

Note: If the door closes, see “Unlocking and opening the door manually” 
on page 73.

4 Disconnect the air supply. See “Disconnecting the air supply” on page 72.

If you do not disconnect the air supply or turn off the air source, the door 
closes when the rotor is turned.

                                                        

CAUTION If the bucket lock is extended when a bucket is misaligned, turning the 
rotor manually could cause the rotor or the bucket to collide with the bucket lock and 
damage the bucket, rotor or bucket lock. Ensure that the air supply is turned off before 
manually rotating the rotor.
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Setting the bucket 1 teachpoint 

The following procedure takes measurements of the farthest points the bucket 
can rotate counterclockwise (Capture 1) and clockwise (Capture 2) when a 
robot gripper is positioned over a bucket. The software averages these 
positions to center the bucket around the gripper and calculate the bucket 
teachpoint.

Figure Robot gripper positioned over a bucket in the Centrifuge (top view)

Alternatively, you can set an approximate teachpoint using a visual alignment 
method. For details, see “Visually aligning the bucket position” on page 53.

To mechanically align and teach the bucket 1 position:

1 Manually rotate the rotor, until the bucket is visually aligned with the top 
edge of the door, as the following figure shows.

Figure Centrifuge bucket (A) misaligned and (B) properly aligned with the top edge of the door

2 Insert the robot gripper into the Centrifuge so that the gripper is centered 
in the Centrifuge door. The gripper must be inserted far enough so that 
when the rotor is turned, the buckets contact the gripper.
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3 Set the Capture 1 coordinates for bucket 1:

a Manually turn the rotor slightly counterclockwise so that the left side 
of the bucket lightly touches the gripper.

b In the Teach Bucket 1 Position dialog box, click Capture 1.

4 Set the Capture 2 coordinates for bucket 1:

a Manually turn the rotor slightly clockwise so that the right side of the 
bucket lightly touches the gripper.

b In the Teach Bucket 1 Position dialog box, click Capture 2.

5 Reconnect and turn on the Centrifuge air.

6 In the Teach Bucket 1 Position dialog box, click OK. 
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7 When the message appears and asks if you want to update the bucket 2 
teachpoint based on this change, click Yes.

8 In the Profiles tab, click Update this profile to save the setting, and then click 
Close this profile.

Note: The profile changes will take effect the next time you initialize the 
profile.

9 Remove the robot gripper from the Centrifuge door, and then use the 
following procedure to set the bucket 2 teachpoint.

IMPORTANT If you do not remove the gripper, it obstructs the closing 
of the door.

Setting the bucket 2 teachpoint

To set the bucket 2 home position teachpoint:

1 In the Profiles tab of Centrifuge Diagnostics, reinitialize the profile.

The Centrifuge rotates bucket 1 to the door, and then unlocks and opens 
the door.

2 Label bucket 1, as follows:

a Turn off the Centrifuge air.

b Attach a piece of colored tape to bucket 1 so that you can keep track 
of bucket 1 versus bucket 2.

Note: Alternatively, you can place an empty microplate in bucket 1.

c Turn on the Centrifuge air.
                                                        



51

4   Setting up the Centrifuge
Setting the bucket home position

Microplate Centrifuge User Guide

3 In the Controls tab, click Go to bucket 2. The Centrifuge closes and locks the 
door, moves bucket 2 to the door, and then opens the door. Bucket 2 
should be visible from the doorway.

Figure Controls tab

Ensure that bucket 2 is visually aligned with the top edge of the door.

4 Turn off the Centrifuge air.

5 Insert the robot gripper into the Centrifuge so that the gripper is centered 
in the Centrifuge door. The gripper must be inserted far enough so that 
when the rotor is turned, the buckets contact the gripper.
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6 To adjust the bucket 2 teachpoint:

a In the Profiles tab, click Reteach bucket 2 position. 

b When the message Timeout waiting for bucket to unlock appears, click OK.

The Teach Bucket 2 Position dialog box opens.

Note: The timeout message for the bucket lock occurs, as expected, 
because the air was turned off in a preceding step.
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7 Set the Capture 1 coordinates for bucket 2 as follows:

a Manually turn the rotor counterclockwise slightly so that the left side 
of the bucket lightly touches the gripper.

b In the Teach Bucket 2 Position dialog box, click Capture 1.

8 Set the Capture 2 coordinates for bucket 2 as follows:

a Turn the rotor slightly clockwise so that the right side of the bucket 
lightly touches the gripper.

b In the Teach Bucket 2 Position dialog box, click Capture 2.

9 Reconnect and turn on the air source to the Centrifuge.

10 In the Teach Bucket 2 Position dialog box, click OK.

11 In the Profiles tab, click Update this profile to save the setting, and then click 
Close this profile.

Note: The profile changes will take effect the next time you initialize the 
profile.

12 Remove the gripper from the Centrifuge door.

IMPORTANT If you do not remove the gripper, it obstructs the closing 
of the door.

Visually aligning the bucket position

If you feel that a visual alignment is sufficient for your application, you may 
use the following procedure. 

To set a teachpoint that precisely centers the robot gripper within the bucket, 
see “Setting the bucket 1 teachpoint” on page 48 and “Setting the bucket 2 
teachpoint” on page 50.

To visually align and teach the bucket position:

1 Manually rotate the rotor, until the bucket is visually aligned with the top 
edge of the door, as the following figure shows.

Figure Centrifuge bucket (A) misaligned and (B) properly aligned with the top edge of the door
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2 In the Teach Bucket 1 Position dialog box, click Capture 1.

3 Without changing the position of the buckets, click Capture 2.

4 Reconnect and turn on the air source to the Centrifuge.

5 In the Teach Bucket 1 Position dialog box, click OK. 

6 When the message appears and asks if you want to update the bucket 2 
teachpoint based on this change, click Yes.

7 In the Profiles tab, click Update this profile to save the setting, and then click 
Close this profile.

Note: The profile changes will take effect the next time you initialize the 
profile.
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Related information

For more information about... See...

Loading and unloading plates in the 
Centrifuge

“Loading and unloading microplates 
and counterweights” on page 62

Centrifuge Diagnostics • “Using Centrifuge Diagnostics to 
perform a spin” on page 65

• Centrifuge Diagnostics Version 8 
Quick Reference

How to use the VWorks software to 
run a protocol

• “Workflow for running a protocol” 
on page 58

• VWorks Automation Control User 
Guide
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5
Performing a spin

This chapter contains the following topics:

• “Workflows for performing spins” on page 58

• “Setting the spin parameters in Centrifuge Diagnostics” on 
page 60

• “Loading and unloading microplates and counterweights” on 
page 62

• “Using Centrifuge Diagnostics to perform a spin” on page 65
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Workflows for performing spins

About the workflows

You can use the Centrifuge to spin microplates in the following ways:

• In a lab automation system, where you run a protocol containing 
Centrifuge tasks to spin multiple microplates in one or more spin cycles. 
See Workflow for running a protocol.

• Using commands in Centrifuge Diagnostics to spin an individual microplate. 
See Workflow for using Centrifuge Diagnostics.

Workflow for running a protocol

You can start one or more spin cycles when you run a protocol containing 
Centrifuge tasks. During the run, the lab automation system robot will load 
and unload sample microplates in the Centrifuge, and the Centrifuge will spin 
the microplates based on the parameters specified in the Centrifuge tasks.

The workflow for starting a run is as follows:

                                                        

Step For this task... See...

1 Start up the lab automation 
system.

Lab automation system user guide, 
such as the BioCel System User 
Guide

2 Open the form or protocol that 
contains the Centrifuge tasks.

VWorks Automation Control User 
Guide

3 Make sure the spin parameters 
are set correctly. 

VWorks Automation Control User 
Guide

4 Determine whether to load the 
counterweight in bucket 2 
before the run.

VWorks Automation Control User 
Guide

5 Load the microplate and the 
counterweight, if required.

“Loading and unloading 
microplates and counterweights” on 
page 62

6 Start the protocol run. VWorks Automation Control User 
Guide
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Workflow for using Centrifuge Diagnostics

You can use Centrifuge Diagnostics to spin individual microplates without 
running protocols. The workflow is as follows.

Step For this task... See...

1 Initialize the Centrifuge in 
Centrifuge Diagnostics.

“Initializing the device profile and 
checking status” on page 42

2 Set the spin parameters. “Setting the spin parameters in 
Centrifuge Diagnostics” on page 60

3 Load the microplate and 
counterweight, if required.

“Loading and unloading 
microplates and counterweights” on 
page 62

4 Start the spin cycle. “Using Centrifuge Diagnostics to 
perform a spin” on page 65
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Setting the spin parameters in Centrifuge Diagnostics

About this topic

This topic explains how to set the spin parameters in Centrifuge Diagnostics to 
spin an individual microplate.

If you want to run a protocol containing Centrifuge tasks to spin multiple 
microplates in one or more spin cycles, see “Workflow for running a protocol” 
on page 58.

Procedure

You set the spin parameters in the Centrifuge Diagnostics Controls tab. When 
you set the spin parameters, you are specifying the motion parameters (1) and 
time parameters (2).

To set the spin parameters:

1 In the Centrifuge Diagnostics Controls tab, set the motion parameters:

Stop at bucket 2Stop at bucket 1

v8.0.1

1

2

Motion parameter Description

Relative Centrifugal Force The rotor speed, in revolutions per minute 
(RPM) or as a multiple of gravity (x g).

Drag the slider left or right to set the 
parameter, or type the desired value in 
either the RPM or x g box.
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2 Set the time parameters:

a Select one of the following to specify how the software should count 
the spin time:

b In the Time to spin box, type the length of total time or time at speed, in 
hh:mm:ss. Alternatively, you can use the up and down arrows to 
specify the length of time.

 

Related information

Acceleration The rate of centrifugation, as a percent of 
the factory- set maximum acceleration.

Drag the slider left or right to set the 
parameter, or type the desired value in 
the % Accel box.

Braking The deceleration of the centrifuge, as a 
percent of the factory- set maximum 
deceleration.

Drag the slider left or right to set the 
parameter, or type the desired value in 
the % Decel box.

Motion parameter Description

Time parameter Description

Total time The total spin time, including acceleration 
and braking.

Time at speed The length of time during which the 
Centrifuge is spinning at the target speed. 
The time does not include acceleration 
and braking.

For more information about... See...

Starting up the Centrifuge “Starting up and shutting down” on 
page 33

Creating profiles “Creating and editing device files” on 
page 34

Loading and unloading plates in the 
Centrifuge

“Loading and unloading microplates 
and counterweights” on page 62

Centrifuge Diagnostics controls and 
indicators

Centrifuge Diagnostics Version 8 
Quick Reference

Using Centrifuge Diagnostics to 
perform a spin

“Using Centrifuge Diagnostics to 
perform a spin” on page 65

How to use the VWorks software to 
run a protocol

“Workflow for running a protocol” on 
page 58
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Loading and unloading microplates and counterweights

Balancing the Centrifuge buckets

The Centrifuge buckets must be the same weight or within the balance 
tolerance to remain balanced during the spin. Unbalanced buckets can cause a 
spin error.

IMPORTANT Each Centrifuge is shipped with a pair of buckets that have been 
balanced to within 1 g of each other. To stay within the balance tolerance of 
the Centrifuge, use only the buckets that shipped with your Centrifuge. Do not 
use buckets from another Centrifuge.

IMPORTANT Before placing microplates and counterweights in the Centrifuge, 
make sure that the weight of the two items are within 10 g of each other to 
avoid a spin error.

If you want to spin one sample microplate, be sure to use a counterweight that 
is within 10 g of the sample microplate. The counterweight can be a microplate 
containing water. If you want to spin two sample microplates together, make 
sure they weigh within 10 g of each other.

Note: The software does not provide indications that the buckets are 
unbalanced when you load the microplates and counterweights. If the buckets 
are unbalanced, the rotor will stop during the spin, and the Balance light in 
Centrifuge Diagnostics will turn on.

IMPORTANT If you are using a microplate counterweight, replace it regularly 
(weekly with heavy use), especially if the microplate is made from polystyrene.

Procedure

You use the Go to bucket commands in the Centrifuge Diagnostics Controls tab 
when loading and unloading microplates and counterweights in the Centrifuge. 

WARNING  Each Centrifuge bucket can hold a microplate or counterweight that 
weighs up to 250 g (8.82 oz). Placing heavier microplates or counterweights in the 
Centrifuge can cause the device to malfunction during operation, damaging the device and 
causing severe injury.

WARNING The Centrifuge door closes and opens automatically when you click the 
Go to bucket commands. Keep away from the Centrifuge door while it is opening or 
closing. The Centrifuge door can cause possible pinching, piercing, or bruising if your hand 
is in the opening when it closes.
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To load microplates or the counterweight in the Centrifuge:

1 In the Centrifuge Diagnostics Controls tab, click Go to bucket 2. The Centrifuge 
closes and locks the door, moves bucket 2 to the door, and then opens the 
door. Bucket 2 should be visible from the doorway.

2 If you are using a counterweight, place it in bucket 2. If you are spinning 
two sample microplates, place one of the microplates in bucket 2.

You can place the microplate or counterweight in the bucket manually or 
using the lab automation system robot. For instructions on how to use the 
robot, see the robot user documentation.

3 Click Go to bucket 1. The Centrifuge closes and locks the door, moves 
bucket 1 to the door, and then opens the door. Bucket 1 should be visible 
from the doorway.

4 Place the sample microplate in bucket 1.

To unload a microplate or counterweight:

1 In the Centrifuge Diagnostics Controls tab, click Go to bucket 1 or Go to bucket 2. 
The Centrifuge closes and locks the door, moves the bucket to the door, 
and then opens the door. The labware should be visible from the doorway.

2 Remove the microplate or counterweight from the bucket.

You can pick up the microplate or counterweight from the bucket manually 
or using the lab automation system robot. For instructions on how to use 
the robot, see the robot user documentation.

3 Repeat steps 1 and 2 to remove the second microplate or the 
counterweight.
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Related information

For more information about... See...

Using Centrifuge Diagnostics to 
perform a spin

“Using Centrifuge Diagnostics to 
perform a spin” on page 65

How to use the VWorks software to 
run a protocol

“Workflow for running a protocol” on 
page 58

Centrifuge Diagnostics controls and 
indicators

Centrifuge Diagnostics Version 8 
Quick Reference
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Using Centrifuge Diagnostics to perform a spin

About this topic

This topic explains how to use Centrifuge Diagnostics to spin an individual 
microplate.

If you want to run a protocol containing Centrifuge tasks to spin multiple 
microplates in one or more spin cycles, see “Workflow for running a protocol” 
on page 58.

Procedure

You use the Start spin cycle command in the Centrifuge Diagnostics Controls tab 
to start spinning the microplate. You can use the Stop at bucket commands to 
stop the spin in progress.

WARNING  The Centrifuge automatically closes the door when you start a spin cycle 
and automatically opens the door when the spin cycle is finished. Keep away from the 
Centrifuge door while it is closing or opening. The Centrifuge door can cause possible 
pinching, piercing, or bruising if your hand is in the opening when it closes.

WARNING  Keep away from the Centrifuge while it is in motion. Not all circumstances 
can be foreseen and serious injury is possible. 

WARNING  Do not attempt to manually unlock the door while the rotor is moving. 
Although no longer powered, the buckets might still be rotating at a dangerous speed.

Stop at bucket 2Stop at bucket 1

v8.0.1
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To start spinning the labware:

1 In the Centrifuge Diagnostics Controls tab, click Start spin cycle. The Centrifuge 
closes and locks the door, and then starts spinning the labware. When it is 
finished, the door opens. Bucket 1 (or the bucket loaded last) should be 
visible in the doorway.

2 To spin another sample microplate, replace the microplate that is in the 
bucket, and then start another spin cycle.

To monitor the progress of a spin cycle:
Check the information in the following areas of the Controls tab:

To stop a spin cycle:
In the Centrifuge Diagnostics Controls tab, click either Stop at bucket 1 or Stop at 
bucket 2. The Centrifuge decelerates, moves the specified bucket to the door, 
and then opens the door.

Stop at bucket 2Stop at bucket 1

v8.0.1

Name of area in the Controls tab Description

Tachometer The current spin speed. 

You can select the desired spin speed unit 
to display: RPM (revolutions per minute), 
or x g (a multiple of gravity).

Total time The length of time, including acceleration 
and braking, of the current spin cycle.

Time at speed The length of time during which the 
Centrifuge has been spinning at the target 
speed (not including acceleration and 
braking). 

Messages Error or status messages.
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Understanding the Status indicators

The following table lists descriptions of the Status indicators in the Controls 
tab.

Related information

Display title Description

Door open Indicates that the Centrifuge door is open.

Door closed Indicates that the Centrifuge door is closed.

Door locked Indicates that the door is locked.

Bucket locked Indicates that the bucket at the door is 
locked in position to prevent the rotor from 
moving.

Bucket unlocked Indicates that the bucket at the door is 
unlocked and the rotor can move.

Balanced Indicates that the buckets are out of balance 
during spinning, because one of the buckets 
has more mass than the other bucket.

In motion Indicates that the buckets are spinning.

Homing Indicates that the Centrifuge is in the homing 
process.

For more information about... See...

Safety guidelines “Safety guidelines” on page 1

Setting the spin parameters “Setting the spin parameters in 
Centrifuge Diagnostics” on page 60

Run a protocol to spin multiple 
microplates in one or more spin 
cycles

“Workflow for running a protocol” on 
page 58

Controls and indicators in 
Centrifuge Diagnostics

Centrifuge Diagnostics Version 8 
Quick Reference
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6
Maintaining the Centrifuge

This chapter contains the following topics:

• “Routine maintenance and cleaning” on page 70

• “Disconnecting the air supply” on page 72

• “Unlocking and opening the door manually” on page 73

• “Removing the buckets” on page 74

• “Testing the actuators” on page 76

• “Replacing the fuse” on page 79

• “Troubleshooting hardware problems” on page 81

• “Troubleshooting Centrifuge error messages” on page 82

• “Reporting problems” on page 84
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Routine maintenance and cleaning

Before you start

This topic provides guidelines for periodic routine maintenance and cleaning.

Preventive maintenance

To keep your Centrifuge working properly, Agilent Technologies recommends 
that you schedule at least one maintenance visit every two years. To schedule 
the maintenance service, contact Agilent Automation Solutions Technical 
Support.

Spindle lubrication
The Centrifuge requires no lubrication except for the spindle, which has been 
designed to remain lubricated for two years of operation.

Do not attempt to lubricate the spindle yourself. If you hear squeaking noises, 
or notice that it takes longer for the Centrifuge to reach the set spin velocity, 
contact Agilent Automation Solutions Technical Support. 

Bucket pin lubrication
The Centrifuge bucket pins use bushings and do not require lubrication. 

If the buckets do not swing freely, do not attempt to lubricate the bucket pins 
yourself. Contact Agilent Automation Solutions Technical Support.

Centrifuge rotor

WARNING To prevent potential injury or equipment damage, always disconnect the 
Centrifuge power, air, and serial cable before performing any cleaning or maintenance.

WARNING Sample plates may contain toxic, caustic, or radioactive substances. If a 
sample plate containing anything other than innocuous materials breaks apart in the 
Centrifuge, contact Agilent Automation Solutions Technical Support.

CAUTION If labware breaks apart inside the Centrifuge, ensure that all the fragments are 
removed. Labware fragments can interfere with moving parts and potentially damage the 
Centrifuge.

CAUTION Use only the recommended cleaning materials. Using other cleaning solutions 
and materials can cause damage to the device. Do not use abrasive, corrosive cleaning 
agents. Do not use metal brushes.

CAUTION Trapped liquids in the Centrifuge may cause corrosion inside the device.

CAUTION The Centrifuge has a permanently attached rotor. Tampering with or adjusting 
the rotor mounting screw, which fastens the rotor to the central motor axle, can result in 
equipment damage. If the rotor mounting screw requires maintenance, contact Agilent 
Automation Solutions Technical Support.
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Routine cleaning procedure

Clean the Centrifuge weekly or as needed. Do not let liquids contact:

• The electronic components

• Mechanical components inside the motor assembly

• The spindle support assembly

To clean the Centrifuge:

1 Use standard laboratory wipes and a mild detergent or isopropyl alcohol to 
clean the exterior painted white surfaces and the metal surfaces of dust, 
grime, chemical deposits, and other debris.

2 Remove the buckets. Inspect and clean the interior. 

3 Clean the buckets using standard laboratory wipes and a mild detergent or 
isopropyl alcohol.

4 Install the buckets.

Cleaning up broken plates 

Counterweight plates are particularly susceptible to falling apart because of 
repeated wear. However, the fluid spilled from a counterweight plate is usually 
water, which is easy to clean up.

Whenever a plate breaks apart in the Centrifuge, follow these guidelines:

• Depending on the amount of spillage, you may need to remove the buckets, 
or disassemble the Centrifuge.

To remove the buckets, see “Removing the buckets” on page 74.

If the Centrifuge might require disassembly, contact the Automation 
Solutions Technical Support.

• Use a long pair of tweezers to remove broken plate fragments.

• If not much liquid spilled, you can vacuum up smaller plate fragments.

• Make sure that excess liquid is removed. Avoid using the Centrifuge until it 
has dried completely.

Related information

For more information about... See...

Disconnecting the air supply “Disconnecting the air supply” on 
page 72

Unlocking the door “Unlocking and opening the door 
manually” on page 73

Removing the buckets “Removing the buckets” on page 74

Installing the buckets “Installing the buckets” on page 25

Reporting problems “Reporting problems” on page 84
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Disconnecting the air supply

When to disconnect the air supply

Disconnect the air supply before:

• Performing maintenance on the Centrifuge

• Cleaning the Centrifuge

• Cleaning up broken plates

Procedure

To disconnect the air line:

1 At the back of the Centrifuge, push in the orange locking collar to release 
the air line.

2 Gently, pull on the air line with your free hand until the tubing comes out.
 

Related information

WARNING  Working with open, charged air lines can result in injury. To prevent 
potential injury or equipment damage, turn off the air supply before disconnecting the air 
line from the Centrifuge.

00080
VSpin
attach air hose

For more information about... See...

Connecting the air supply “Connecting the device” on page 27

Specifications for air supply “Laboratory requirements” on page 15

Reporting problems “Reporting problems” on page 84
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Unlocking and opening the door manually

Before you start

Before cleaning or performing maintenance on your Centrifuge, you will need 
to unlock and open the door.

To disconnect the air hose, see “Disconnecting the air supply” on page 72.

Procedure

To manually unlock and open the door:

1 Put a small, thin tool, such as a large unfolded paperclip, through the hole 
at the upper left of the door to push against and fully retract the lock pin. 

Ensure that the tool is inserted at an angle so that it goes between the 
door column and the cover, as the following figure (A) shows

At the same time, push upward in the indentation (B) in the door with 
your other hand.

Figure Centrifuge (A) door-lock access hole and (B) door indentation

WARNING To prevent potential injury or equipment damage, always disconnect the 
Centrifuge power, air, and serial cable before performing any cleaning or maintenance.

WARNING To prevent potential injury or equipment damage, do not attempt to 
manually unlock the door while the rotor is moving. Although no longer powered, the 
buckets may still be rotating at a dangerous speed.

00083
VSpin
Manual door open

Centrifuge

A

B

uge

00111c
VSpin
cutaway
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2 Remove the tool after the door begins to open, to continue opening the 
door. Otherwise, the tool will obstruct the door’s movement.

 

Related information

Removing the buckets

About this topic

You should remove the buckets before cleaning or moving the Centrifuge.

Before you start

Ensure that the power and air are turned off. To disconnect the air hose, see 
“Disconnecting the air supply” on page 72.

To access the buckets when the air is turned off, you open the door manually. 
See “Unlocking and opening the door manually” on page 73.

Procedure

To remove a bucket:

1 Roll the bucket as the following figure shows, and then pull the bucket 
towards you until it comes free of the pins.

For more information about... See...

VWorks software • VWorks Automation Control Setup 
Guide

• VWorks Automation Control User 
Guide

Controls and indicators in 
Centrifuge Diagnostics

Centrifuge Diagnostics Version 8 
Quick Reference

Reporting problems “Reporting problems” on page 84

WARNING To prevent potential injury or equipment damage, always disconnect the 
Centrifuge power, air, and serial cable before performing any cleaning or maintenance.
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2 Rotate one end of the bucket towards you, and turn it upside down.

3 Remove the bucket from the door opening.

00108
VSpin
Rotor assembly - bucket rotated

00114
VSpin
bucket removed

00113
VSpin
bucket removal

For more information about... See...

Unlocking the door manually “Unlocking and opening the door 
manually” on page 73

Installing the buckets “Installing the buckets” on page 25

Reporting problems “Reporting problems” on page 84
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Testing the actuators

About this topic

To diagnose problems with the following Centrifuge actuators, you can test 
them in Centrifuge Diagnostics:

• Lock Bucket and Unlock Bucket

• Lock Door and Unlock Door

• Open Door

Note: The door cannot be opened until it is unlocked.

Before you start

Initialize the Centrifuge in Centrifuge Diagnostics. For instructions, see 
“Initializing the device profile and checking status” on page 42.

The following figure shows the actuator controls in the Controls tab.

Figure Actuator controls in the Controls tab

If there are problems with the actuators, check the indicators in the Status 
area and check the Messages area of the Controls tab.
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Locking and unlocking the bucket assembly

The bucket assembly (buckets and rotor) locks automatically before a plate is 
picked from or placed on a bucket. When locked, the buckets do not swing and 
the rotor does not turn. You can also manually lock the bucket assembly.

To unlock the bucket assembly:
On the Controls tab, click Unlock Bucket.

The bucket assembly is now free to spin, and can be moved by hand.

To lock the bucket assembly:
On the Controls tab, click Lock Bucket.

The bucket assembly locks, restricting bucket swinging and rotor spinning.

Locking and unlocking the door

Between spin cycles, you can command the door to lock or unlock.

The door must be locked before you can start a spin, and remains locked 
throughout the spin. If the rotor starts spinning, the hardware interlocks close 
and lock the door automatically.

To lock the door:

In the Controls tab, click Lock Door.

The door locks, and cannot be opened without sending an unlock command or 
unlocking it manually.

To unlock the door:
In the Controls tab, click Unlock Door.

The door unlocks.

Opening and closing the door

Figure Centrifuge door

Between spin cycles, you can command the door to open.

WARNING  Keep away from the Centrifuge door while it is opening or closing. The 
Centrifuge door can cause possible pinching, piercing, or bruising if your hand is in the 
opening when it closes.
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The door must be closed before you can start a spin.

The door will not open until it is unlocked.

To open the door:

1 In the Controls tab, verify that the door is unlocked by checking the Door 
locked status light in the Status area.

2 Click Open Door.

The door opens.

To close the door:
Click Close door.

The door closes.

Checking error messages

The following types of error and status messages appear in the Messages area 
of the Control tab:

• Bucket lock failed

• Door lock failed

• Door open failed

Door closed status anomaly

The Door closed sensor is not triggered when the door is fully closed, but 
rather when it is just starting to close.

As a result, it is occasionally possible for the door to be open slightly, but for 
the Door closed status light to still be lit. 

Related information

For more information about... See...

Error messages “Troubleshooting Centrifuge error 
messages” on page 82

Controls and indicators in 
Centrifuge Diagnostics

Centrifuge Diagnostics Version 8 
Quick Reference

Reporting problems “Reporting problems” on page 84
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Replacing the fuse

Before you start

Ensure that you have the following:

• Fuse of the specified type: 7 A, 250 V, 3 AG

• Flathead screwdriver
Procedure

To replace the fuse in the power switch:

1 Shut down the Centrifuge, and unplug the power cable from the rear panel 
connector.

2 At the rear panel power switch enclosure, use a small flat- head 
screwdriver (2.5 mm) to pry open the tab at the top of the enclosure and 
open the enclosure cover.

Figure Fuse enclosure location

3 Insert the screwdriver head in the enclosure notch to dislodge the fuse 
cartridge. Slide the fuse cartridge all the way out of the enclosure.

WARNING To prevent potential injury or equipment damage, disconnect the instrument 
power, air, and communication cables before performing the following procedure.

CAUTION A blown fuse can indicate an over-current condition caused by a ground fault or 
faulty electronics. If the fuse blows again after replacement, troubleshoot the problem by 
disconnecting the power supply and inspecting the AC wiring through the power entry 
module.

CAUTION Use only the specified fuse type for replacement. Using an incorrect fuse can 
damage the Centrifuge.
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Figure Fuse enclosure location

4 Replace the fuse in the cartridge.

5 Slide the fuse cartridge back into the fuse enclosure.

6 Press the enclosure cover securely into the closed position.

7 Plug in the power cord at the rear panel connector.
 

Related information

For more information about... See...

Safety guidelines “Safety guidelines” on page 1

Troubleshooting problems “Troubleshooting hardware problems” 
on page 81

Reporting problems “Reporting problems” on page 84
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Troubleshooting hardware problems

Refer to the following table to resolve common errors. If your particular issue 
is not in the table, or if the recommended steps do not solve your problem, see 
“Reporting problems” on page 84.

Problem Possible cause Solution

The Centrifuge does not 
turn on.

The site does not meet the 
electrical requirements.

See “Laboratory requirements” on 
page 15.

The device is not connected 
to the power source, or the 
power cord is damaged.

Ensure that you are using the correct 
country- specific power cord and plug.

Inspect the power cord and 
connections, and ensure that the device 
is connected to the power source.

The AC inlet fuse is bad. See “Replacing the fuse” on page 79.

If the fuse blows immediately after 
replacement, stop using the device and 
see “Reporting problems” on page 84. 

The buckets were level 
before a spin cycle. But 
after the spin cycle the 
buckets are not level.

The upper corner of a deep-
well microplate with lid is 
hitting the rotor during the 
spin cycle.

Ensure that your labware fits within 
the Centrifuge specifications for 
labware height. For details, see 
“Labware specifications” on page 20.

Note: If the microplate meets the size 
specifications without adding the lid, 
you can seal the microplate instead of 
using a lid.
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Troubleshooting Centrifuge error messages

Refer to the following table to resolve common errors. If your particular issue 
is not in the table, or if the recommended steps do not solve your problem, see 
“Reporting problems” on page 84.

Error Possible cause Solution

A position- error condition 
was encountered

The Centrifuge failed to go to 
the specified position.

Check to see if something is blocking 
the rotor, such as a piece of plastic 
from a plate.

Aborting current process You have chosen an action 
that has aborted this 
process. For example, you 
clicked Open Door before the 
door finished closing.

Wait for the current action to finish 
before you perform the next action.

An imbalance condition was 
encountered

The buckets were imbalanced 
during a spin.

Ensure that the weight in the buckets 
is balanced before you start a spin. 
See “Starting a Spin” on page 58.

Bad acceleration percentage: 
Must be between 1.0 and 
100.0

The spin parameters are out 
of range.

On the Controls tab, choose an 
acceleration percentage between 1.0 
and 100.0

Bad bucket number: Must be 
1 or 2

Select bucket 1 or bucket 2.

The Centrifuge has only two buckets.

Bad deceleration percentage: 
Must be between 1.0 and 
100.0

On the Controls tab, choose a 
deceleration percentage between 1.0 
and 100.0

Bad time: Must not be 
negative

Choose a time value that is 0 or 
greater.

Bad timer mode: Must be 0 
or 1

Choose a value of 0 or 1.

Bad velocity percentage: 
Must be between 1.0 and 
100.0

Choose a value between 1.0 and 
100.0.

Could not connect to the 
Centrifuge

Power or communications 
are not functioning properly.

Ensure that the:

• Power cord is properly plugged in 
to the Centrifuge power entry and 
the wall outlet.

• Power switch is turned on.

• Fuse is not burned out.

• Serial cable is properly plugged 
into the Centrifuge and the 
computer.

• Centrifuge is plugged into the 
serial port specified in the 
profile.



83

6   Maintaining the Centrifuge
Troubleshooting Centrifuge error messages

Microplate Centrifuge User Guide

<the action> may not be 
called at present time

The Centrifuge is currently 
performing another process, 
and cannot perform the 
requested action. For 
example, the door cannot be 
opened while the rotor is 
spinning.

Wait for the current action to finish 
before you perform the next action.

NmcNoOp() failed: 
Communication likely failed

The Centrifuge may have 
become disconnected during 
operation.

Ensure that the:

• Power cord is properly plugged in 
to the Centrifuge power entry and 
the wall outlet.

• Power switch is turned on.

• Serial cable is properly plugged 
into the Centrifuge and the 
computer.

Profile does not exist The Centrifuge profile does 
not exist.

Create a new profile or select an 
existing one.

Time out error The action did not complete 
within the allotted time.

The power or 
communications to the 
Centrifuge has been 
interrupted.

Ensure that the:

• Power cord is properly plugged in 
to the Centrifuge power entry and 
the wall outlet.

• Fuse is not burned out.

• Power switch is turned on.

• The serial cable is properly 
plugged into the Centrifuge and 
the computer.

Perform the action again.

Tried to actuate bucket lock 
but failed

The system may have 
insufficient air pressure.

Check to make sure that the:

• Air hose is properly connected to 
the Centrifuge and to the air 
source

• Air is turned on at the source

• Air pressure is at the proper level 
as listed in “Laboratory 
Requirements” on page 23

Error Possible cause Solution
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Reporting problems

Contacting Automation Solutions Technical Support 

If you find a problem with the Centrifuge, contact Automation Solutions 
Technical Support. For contact information, see Notices on the back of the title 
page. 

Reporting hardware problems

When contacting Agilent Technologies, make sure you have the serial number 
of the device ready.

Reporting software problems

When you contact Automation Solutions Technical Support, make sure you 
provide the following:

• Short description of the problem

• Relevant software version number (for example, automation control 
software, diagnostics software, and firmware)

• Error message text (or screen capture of the error message dialog box)

• Relevant files, such as log files

Reporting user guide problems

If you find a problem with this user guide or have suggestions for 
improvement, send your comments in an email to 
documentation.automation@agilent.com.
 

Related information

For more information about... See...

Troubleshooting hardware problems “Troubleshooting hardware problems” 
on page 81

Error messages “Troubleshooting Centrifuge error 
messages” on page 82

Safety guidelines “Safety guidelines” on page 1

mailto:documentation.automation@agilent.com
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